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Einleitung
  Symbole und Konventionen

Hinweis auf mögliche Beschädigungen des Druckers, die bei Nichtbeachtung einer 
Empfehlung entstehen können.

Hinweis auf Informationen, die wichtige Punkte des Haupttextes präzisieren oder ergänzen.

 

Erweitert (Advanced) > Anpassen (Fit)

Text auf der Benutzeroberfläche von Badge Studio erscheint, der angeklickt werden kann.

Pfad auf der Website Evolis, um auf die Dokumentation oder die Installationsdateien des 
Druckertreibers zuzugreifen. 

Funktionen, die nur in der PLUS Ausgabe von Badge Studioverfügbar sind.

  Wie funktioniert Badge Studio
Ein Dokument in Badge Studioverbindet das Kartendesign mit der Datenverwaltung für eine Kartenserie 
über den Karten-Design-Bereich und die Datentabelle. Diese beiden funktionieren parallel: Eine Karte 
der Serie entspricht immer einer Reihe in der Datentabelle, und die Elemente auf der Kartenvorlage 
können mit den Spalten in der Datentabelle verknüpft werden.

  Kartendesign  

  Um ein neues Dokument zu beginnen, wählen Sie 
entweder eine vordefinierte Kartenvorlage oder eine leere 
Kartenvorlage aus. 

  Dann fügen Sie im Design-Bereich die gewünschten 
Elemente (Text, Bilder, Barcodes, Allergeninformationen 
und Formen) ein und personalisieren, dimensionieren und 
positionieren diese für Ihre Kartenserie.

Sie können entscheiden, welche Textelemente, Bilder und 
Barcodes sich von Karte zu Karte unterscheiden und welche 
auf allen Karten gleich bleiben.

  Verwaltung von Daten  

  In der Datentabelle bearbeiten Sie die Daten (Text, Bilder, 
Barcode-Daten und Allergeninformationen), die von Karte 
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zu Karte unterschiedlich sind. Fügen Sie Reihen hinzu, um 
Karten auf der Basis der gleichen Vorlage hinzuzufügen, 
welche dieselben Elemente wie die anderen Karten 
enthalten.

  Daten aus anderen Dokumenten mithilfe eines Assistenten 
importieren.

  Druck  

  Zum Drucken von Karten, wählen Sie eine, mehrere oder 
alle Reihen in der Datentabelle, bevor Sie den 
Druckvorgang konfigurieren und starten.

  Was die Version bietetPLUS
Es sind eine STANDARD- und eine PLUS-Version von Badge Studio verfügbar. Die Version PLUS umfasst 
im Vergleich zur STANDARD-Version eine Reihe zusätzlicher Funktionen.

Gestalten einer Karte mit Vorder- und Rückseite

Kartenelemente mit Passwort sperren

Daten importieren

Duplizierte Reihen beim Importieren von Daten löschen

Spalte sperren/entsperren

Vorder- und Rückseite mithilfe eines Assistenten bedrucken

  Standardmäßig enthält die Badgy 100-Lösung die STANDARD-Version. Die Badgy 200-Lösung umfasst 
die Version PLUS.

Benutzer der STANDARD-Version haben die Möglichkeit, die zusätzlichen Vorteile durch Aktivieren einer 
Lizenz für die PLUS-Version zu nutzen.

  Startseite
Die Startseite wird angezeigt, wenn Sie Badge Studio starten oder ein Dokument schließen.
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Erstellen eines neuen Dokuments

Durchsuchen der zuletzt geöffneten 
Dokumente

 

Dokument öffnen

Dokument umbenennen

Nicht angezeigtes Dokument öffnen Datei (File) > Dokument öffnen (Open a document)

Sprache wechseln Datei (File) > Sprachen (Languages)



Installation, Lizenz & Versionen Treiber und Software installieren

7

Installation, Lizenz & Versionen
Treiber und Software installieren

Mindestanforderungen

  Betriebssystem: Windows® / macOS(Softwarekompatibilitätstabelle)

RAM: 2 GB

Freie Speicherkapazität auf Festplatte: 1,5 GB

Bildschirmauflösung: 1024 x 768 Pixel

Konnektivität: 1 USB-Anschluss

Mit DirectShow, WIA oder TWAIN kompatible Webcam

Installieren von Treiber und Software von einem USB-Stick

 
Bei allen Windows-Versionen sind Administratorrechte erforderlich, um den Druckertreiber 
installieren zu können.

Drucker erst anschließen, wenn der Installationsprozess abgeschlossen ist

 1. Ein USB-Stick, der den Treiber und die Software enthält, ist im Lieferumfang der Lösung 
inbegriffen.

 2. Inhalt des USB-Sticks mithilfe des Windows Explorers / macOS Finders öffnen.

 3. Die Datei Setup.exe (für Windows) / Setup.pkg (für macOS) öffnen.

Standardmäßig wird dadurch die Installation des Druckertreibers und der Software Badge 
Studio gestartet.

 

 4. Nach Abschluss des Installationsprozesses können Sie den Drucker über das USB-Kabel an Ihren 
Computer anschließen.

Herunterladen und Installieren von Treiber und Software

 
Bei allen Windows-Versionen sind Administratorrechte erforderlich, um den Druckertreiber 
installieren zu können.

Drucker erst anschließen, wenn der Installationsprozess abgeschlossen ist

 1. Die Seite Badge Studio auf www.evolis.com > Support-Abschnitt > Produktseite aufrufen.

 2. Auf die neueste Version der Datei .exe (für Windows) / .pkg (für macOS) klicken.

 3. Auf Herunterladen (Download) klicken.

https://downloads.evolis.com/evolis/documents/evolis-application-software-compatibilty-chart.pdf
https://de.evolis.com/
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▶  Die Datei .exe/.pkg wird auf Ihren Computer heruntergeladen.

 4. Wenn der Download abgeschlossen ist, die Datei Setup.exe / Setup.pkg öffnen.

Standardmäßig wird dadurch die Installation des Druckertreibers und der Software Badge 
Studio gestartet.

 

 5. Die Installationsschritte auf dem Bildschirm befolgen.

 6. Nach Abschluss des Installationsprozesses können Sie den Drucker über das USB-Kabel an Ihren 
Computer anschließen.

Badge Studio deinstallieren.

  Windows

 1. Vom Windows-Startmenü aus in den Ordner BadgeStudio wechseln und BadgeStudioUninstall 
auswählen.

 2. Auf Entfernen klicken, um die Software vom Computer zu deinstallieren.

macOS

 1. Vom Ordner Programme in den Badge Studio in den Papierkorb legen.

 2. Die Konfigurationsdateien und die Dokumentliste müssen manuell gelöscht werden.

Software, Lizenzen/Versionen verwalten

Aktivieren einer Lizenz

   1. Eine Lizenz für die PLUS Edition bei Ihrem Badgy-Händler kaufen.

 2. Von Badge Studio zu Datei (File) > Lizenz  Badge Studio gehen.

 3. Den Aktivierungscode eingeben, den Sie von Ihrem Händler erhalten haben

Wenn Sie einen 64-stelligen Code haben, kreuzen Sie das entsprechende Kästchen an.

 4. Auf Lizenz aktivieren (Activate License) klicken.

Aktivieren einer Lizenz auf einem Offline-Computer

 
Eine PLUS-Lizenz kann jeweils auf einem Computer aktiviert werden.

Auf dem Offline-Computer:

 1. USB-Stick einstecken.

 2. Badge Studio starten.
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 3. Zu Datei (File)  >Lizenz  Badge Studio gehen.

 4. Auf Weitere Lizenzoptionen (More licensing options) klicken, dann Aktivieren/Deaktivieren 
der Lizenz offline (Activate / Deactivate license offline) wählen und auf Offline 
aktivieren/deaktivieren (Activate / Deactivate Offline) klicken.

 5. Aktivieren der Lizenz auf diesem Computer (Activate license on this computer) wählen und 
auf Weiter > (Next >) klicken.

 6. Speicherort für die .txt-Datei auf dem USB-Stick wählen.

 7. Auf Weiter > (Next >) klicken, ohne jedoch den Assistenten zu schließen

 8. USB-Stick herausziehen.

Auf einem Computer mit Internetverbindung und installiertem Badge 
Studio: 

 1. USB-Stick einstecken.

 2. Badge Studio starten.

 3. Zu Datei (File)  >Lizenz  Badge Studio gehen.

 4. Auf Weitere Lizenzoptionen (More licensing options) klicken, dann Aktivieren/Deaktivieren 
der Lizenz offline (Activate / Deactivate license offline) wählen und auf Offline 
aktivieren/deaktivieren (Activate / Deactivate Offline) klicken.

 5. Aktivieren der Lizenz auf einem Offline-Computer (Activate license for an offline 
computer) wählen und auf Weiter > (Next >) klicken.

 6. Die .txt-Datei auf dem USB-Stick auswählen.

 7. Den Aktivierungscode eingeben, den Sie von Ihrem Badgy-Händler erhalten haben.

 8. Auf Lizenz aktivieren (Activate License) klicken.

 9. Speicherort für die .license-Datei auf dem USB-Stick wählen.

 10. USB-Stick entnehmen.

Auf dem Offline-Computer:

 1. USB-Stick einstecken.

 2. Im vorher geöffneten Assistenten die Datei .license auf dem USB-Stick wählen

 3. Auf Lizenz aktivieren (Activate License) klicken.

▶  Der Assistent aktiviert die PLUS-Lizenz auf dem Offline-Computer.

Eine Lizenz deaktivieren.

  Eine mit einem Upgrade-Coupon aktivierte Lizenz kann auf einem Computer mit Internetverbindung 
deaktiviert werden.

 1. Badge Studio starten.

 2. Zu Datei (File)  >Lizenz  Badge Studio gehen.

 3. Auf Weitere Lizenzoptionen (More licensing options) klicken und Aktivieren / Deaktivieren 
der lizenz (Activate / deactivate license) auswählen.

 4. Auf Lizenz deaktivieren (Deactivate license) klicken.
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▶  Badge Studio wird für die Deaktivierung mit dem Lizenzserver verbunden.

Deaktivieren einer Lizenz auf einem Offline-Computer

  Eine PLUS-Lizenz kann maximal auf einem Offline-Computer aktiviert werden. Deshalb müssen Sie 
unter Umständen eine PLUS-Lizenz auf einem Computer deaktivieren, bevor Sie eine Lizenz auf einem 
anderen aktivieren können.

Auf dem Offline-Computer mit der Lizenz, die deaktiviert werden muss

 1. USB-Stick einstecken.

 2. Badge Studio starten.

 3. Auf der Startseite auf Datei (File)  >Lizenz  Badge Studio klicken

 4. Auf Weitere Lizenzoptionen (More licensing options) klicken, dann Aktivieren/Deaktivieren 
der Lizenz offline (Activate / Deactivate license offline) wählen und auf Offline 
aktivieren/deaktivieren (Activate / Deactivate Offline) klicken.

 5. Deaktivieren der Lizenz auf diesem Computer (Deactivate license on this computer) 
wählen und auf Weiter > (Next >) klicken.

 6. Speicherort für die .txt-Datei auf dem USB-Stick wählen.

 7. USB-Stick entnehmen.

Auf einem Computer mit Internetverbindung und installiertem Badge Stu-
dio: 

 1. USB-Stick einstecken.

 2. Badge Studio starten.

 3. Auf der Startseite auf Datei (File)  >Lizenz  Badge Studio klicken.

 4. Auf Weitere Lizenzoptionen (More licensing options) klicken, dann Aktivieren/Deaktivieren 
der Lizenz offline (Activate / Deactivate license offline) wählen und auf Offline 
aktivieren/deaktivieren (Activate / Deactivate Offline) klicken.

 5. Deaktivieren der Lizenz auf einem Offline-Computer (Deactivate license for an offline 
computer) wählen und auf Weiter > (Next >) klicken.

 6. Die .txt-Datei auf dem USB-Stick auswählen.

 7. Auf Lizenz deaktivieren (Deactivate license) klicken.

▶  Die Lizenz wird deaktiviert und kann genutzt werden, um auf einem anderen Computer die 
PLUS-Lizenz zu aktivieren

Aktualisieren der Software auf die neueste Version

  Von Badge Studioz u Hilfe (Help) > Suche nach Software-Updates (Check for software updates) 
gehen.

 l Wenn Ihre Software aktuell ist, wird eine Bestätigung angezeigt:
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 l Wenn eine Aktualisierung verfügbar ist

 a. Auf Herunterladen (Download) klicken.

▶  Eine .exe-Datei (Windows) /.pkg-Datei (macOS) wird auf Ihren Computer 
heruntergeladen.

 b. Die heruntergeladene .exe-Datei / .pkg öffnen.

 c. Die Installationsschritte auf dem Bildschirm befolgen.

Suche nach der letzten Version deaktivieren

  Standardmäßig sucht Badge Studio beim Versuch, eine Verbindung zu einem Remote-Server 
herzustellen, nach der neuesten Version der Software.

 1. Von Badge Studioz u Hilfe (Help) > Suche nach Software-Updates (Check for software 
updates) gehen.

 2. Das Kästchen Aktualisierungen automatisch überprüfen (Automatically check for updates) 
deaktivieren.
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Kartendesign
Bereich für Karten-Design

  Der Bereich für das Karten-Design wird angezeigt, nachdem Sie eine Kartenvorlage ausgewählt oder ein 
Dokument geöffnet haben. Standardmäßig wird nur die Vorderseite angezeigt.

  Ein-/Auszoomen (Vergrößern/Verkleinern)
 

  Die optimale Zoomstufe zum Anzeigen der Karte 
einstellen

Rückseite anzeigen

  Formatierung reproduzieren
 

  Bearbeitungsschritte rückgängig machen
 

  Bearbeitungsschritte wiederholen
 

  Speichern des aktuellen Dokuments
 

  Drucken der ausgewählten Karten
 

  Das aktuelle Dokument schließen und zur Startseite 
zurückkehren
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  Auswählen der Maßeinheiten zum 
Dimensionieren/Positionieren von Elementen

Ansicht (View) > Maßeinheiten (Measurement 
System)

  Ein-/Ausblenden des Rasters, das zur visuellen 
Größenbestimmung/Positionierung von Elementen 
dient

Ansicht (View) > Raster anzeigen (Show Grid)

  Anzeigen/Ausblenden von sich kreuzenden Linien 
in der Mitte der Karte, die dazu dienen, Elemente 
visuell zu positionieren

Ansicht (View) > Kennzeichnungen (Guide 
Lines)

  Anzeigen/Ausblenden der Hilfslinien für die 
horizontale und vertikale Position von Elementen

Ansicht (View) > Lineal anzeigen (Show Rulers)

  Aktivieren/Deaktivieren der Ausrichtung der 
Elemente auf dem Raster

Ansicht (View)>Ausrichten (Snap)>An das 
Raster anpassen (Snap To Grid)

  Anzeigen/Ausblenden der Ausrichtung der 
Elemente mit anderen

Ansicht (View)>Ausrichten (Snap)>An den 
Objekten ausrichten (Snap To Objects)

  Anzeigen des Bereichs, der durch den Schildhalter 
verdeckt wird

Ansicht (View) > Platz für Schildhalter anzeigen 
(Show tag holder footprint on card)

  Ausgerichtete Elemente

Feine blaue Linien in der Verlängerung des 
Elements

  Visuelles Drehen eines Elements

 

Rote gestrichelte Linien, wenn das Element um 
90°/180°/270° gedreht wird

   

Gewählter Hintergrund

rot gestrichelte Linie am Kartenrand

Kartenvorlage auswählen

Eine vordefinierte Kartenvorlage auswählen

   1. Auf der Startseite auf diese Symbole klicken:

 

▶  Ein Assistent präsentiert eine Reihe von Kartenvorlagen
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 2. Für welche Anwendung sind Ihre Karten gedacht:

 

 3. Zum Verfeinern der Auswahl der Kartenvorlagen diese Dropdown-Listen und Kontrollkästchen 
verwenden:

 

 

 4. Um Details zu Elementen auf der Karte zu sehen, den Mauszeiger über eine Karte bewegen und 

auf das Informationssymbol klicken: 

 5. Eine Kartenvorlage auwählen und auf Erstellen (Create) klicken.

▶  Der Kartendesign-Bereich wird geöffnet. Hier haben Sie die Möglichkeit, der Karte Elemente 
hinzuzufügen und diese zu personalisieren

Blanko-Kartenvorlage auswählen

   1. Auf der Startseite auf diese Symbole klicken:

 

▶  Ein Assistent präsentiert eine Reihe von Kartenvorlagen

 2. Klicken auf

 

▶  Es wird eine Auswahl von Kartenvorlagen angezeigt:

 3. Zum Verfeinern der Auswahl der Kartenvorlagen diese Filter verwenden:

 

 4. Eine Kartenvorlage auwählen und auf Erstellen (Create) klicken.
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▶  Der Kartendesign-Bereich wird geöffnet. Hier haben Sie die Möglichkeit, der Karte Elemente 
hinzuzufügen und diese zu personalisieren

Hintergrund der Karte personalisieren

  Vordefinierten Kartenhintergrund auswählen

 1. Auf der gewünschten Kartenseite in einen leeren Bereich klicken, der keine Elemente enthält.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Hintergrund (Background) auf einen der vordefinierten Hintergründe klicken.

 a. Für die Vorderseite: Auf das Kartensymbol links klicken. 

 

 b. Für die Rückseite: Auf das Kartensymbol rechts klicken.

 

   

Bild als Kartenhintergrund wählen

 1. Auf der gewünschten Kartenseite in einen leeren Bereich klicken, der keine Elemente enthält.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt. 

 2. UnterHintergrund (Background) auf das Verzeichnis-Symbol klicken:

 3. Eine Bilddatei auswählen.

Kartenhintergrund formatieren.

Auf der gewünschten Kartenseite in einen leeren Bereich klicken, der keine Elemente enthält.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt. 

    Bildeigenschaften (Image properties)

Farben des Originalbilds

  Graustufen

  Monochrom
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  Negativ

 
Wenn Sie mit einem monochromen (einfarbigen) Farbband drucken, müssen die Bilder ein 
monochromes Format aufweisen (können aber zusätzlich ein Negativformat haben)

  Sättigung / Helligkeit / Kontrast

 

  Wiederherstellen der ursprünglichen Einstellungen
  

  Eine Hintergrundfarbe vom Hintergrund entfernen

 1. Auf der gewünschten Kartenseite in einen leeren Bereich klicken, der keine Elemente enthält.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Bildeigenschaften (Image properties) > Hintergrund löschen (Remove background) 
auf den kleinen Pfeil rechts neben dem Personen-Symbol klicken: 

 

 3. Auf Pipette (Color Picker) klicken.

▶  Der Cursor verwandelt sich in eine Pipette.

 4. Auf eine Stelle mit der betreffenden Farbe klicken.

 5. Unter Toleranz (Tolerance) ziehen Sie den Schieberegler nach links oder rechts, um den 
Schwellenwert anzupassen, ab dem die Farbe entfernt wird.

 6. Um den ursprünglichen Wert wiederherzustellen, auf

   klicken.                                 

Hintergrundbild der Karte beschneiden

 1. In einen leeren Bereich, der keine Elemente enthält, klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Klicken auf: 

 

 3. Die roten Quadrate verschieben, um den gewünschten Bereich des Bildes einzuschließen:
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 4. Auf Zuschneiden (Crop) klicken.

Karten-Hintergrund entfernen

 1. Auf der gewünschten Kartenseite in einen leeren Bereich klicken, der keine Elemente enthält.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Auf den kleinen Pfeil rechts neben dem Landschaftssymbol mit Kreuzchen klicken:

 

In der Dropdown-Liste auf die Seite, deren Hintergrund entfernt werden soll:

 

Text hinzufügen/personalisieren

  Text hinzufügen

Hinzufügen von völlig neuem Text

Auf das Text-Symbol klicken:

 

Hinzufügen von Text aus einer Spalte

Aus der Datentabelle den Spaltentitel auf die Karte ziehen und ablegen.

▶  Ein variables Textelelment, verknüpft mit der entsprechenden Spalte in der Datentabelle, wird auf 
der Karte angezeigt und lässt sich bearbeiten:

Sie können der Text auch später noch fixieren.

Text bearbeiten

 1. Wenn es nicht bereits auf der Karte ausgewählt ist, klicken Sie auf das Textelement.



Kartendesign Text hinzufügen/personalisieren

18

 2. Den gewünschten Text eingeben.

 3. Eingabetaste drücken.

Wenn der Text mit einer Spalte der Datentabelle verknüpft ist, wird er in der entsprechenden Reihe 
ebenfalls geändert.

Text formatieren

Auf das Textelement klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

    Schriftart (Font)

  Textfarbe
 

  Fett / Kursiv / Unterstrichen / Durchgestrichen
 

  Groß-/Kleinschreibung 
 

  Schriftgröße vergrößern / verkleinern

 

  Schriftart

  Größe der Zeichen

  Automatisch angepasste Schriftgröße, um den Text 
an die Abmessungen des Elements anzupassen, 
unter Einhaltung von Maximal-
/Minimalschwellenwerten

Zusätzlich zu Erweitert (Advanced) > 
Schriftgröße (Font Size)  > Minimale und 
maximale Schriftgröße (Minimum and 
maximum sizes)

     

  Positionierung Absatz (Paragraph)

  Vertikale Position innerhalb des Elements

 

  Textausrichtung

 

  Zeilenumbruch (Erzwingen eines Zeilenwechsels, 
wenn erforderlich)  

     

  Element  
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  Hintergrundfarbe / Rahmen

  

  Textformatierung reproduzieren

 1. Auf das Element klicken, dessen Format Sie übernehmen möchten.

Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Auf das Symbol zum Reproduzieren der Formatierung klicken:

 

 3. Auf das Textelement klicken, dessen Format Sie anwenden möchten.

Text fixieren

Texte, Bilder, mit Strichcodes verschlüsselte Daten und Allergeninformationen und Informationen über 
Allergene, die im Gegensatz zu „variabel“ als „fix“ (unveränderlich) bezeichnet werden, erscheinen auf 
sämtlichen Karten Ihres Dokuments und sind stets identisch.

 1. Mit der rechten Maustaste auf das  Element klicken und In variablen Text/ Bild / Barcode 
umwandeln auswählen.

▶  Es öffnet sich ein Fenster, in dem Sie die Umwandlung bestätigen können.

 2. Zur Bestätigung auf OK klicken.

▶  Die verknüpfte Spalte wird aus der Datentabelle entfernt.

Die Daten in dieser Spalte können nicht mehr wiederhergestellt werden.

 

Bild hinzufügen/personalisieren

  Bild hinzufügen

Beim Drucken mit einem Monochrom-Band (Farbband mit nur einer Farbe) sind Bilder mit 
einer Grau-/Farbskala nicht geeignet.

Hinzufügen eines neuen Bildes aus eigenen Dateien

Auf das Landschaftssymbol klicken. 

Neues Bild aus der Webcam hinzufügen
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Der Computer muss mit einer Webcam ausgestattet sein.

 

 1. Auf das Symbol „Fotografieren“ der Kamera klicken.

 2. Dann für die Aufnahme auf das Webcam-Symbol klicken.

 3. Auf Aquire klicken, um das Foto in das Kartendesign einzufügen.

Hinzufügen eines Bildes aus einer Spalte

Aus der Datentabelle den Spaltentitel auf die Karte ziehen und ablegen.

▶  Es erscheint ein variables Bild, das mit der entsprechenden Spalte in der Datentabelle verknüpft ist, 
auf der Karte. Es lässt sich formatieren, dimensionieren und positionieren.

Sie können das Bild auch später noch fixieren.

Bild formatieren

Auf das Bild klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

    Format

  Hintergrundfarbe / Rahmen  

 

    Bildeigenschaften (Image properties)

Farben des Originalbilds

Graustufen

  Monochrom

  Negativ
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Wenn Sie mit einem monochromen (einfarbigen) Farbband drucken, müssen die Bilder ein 
monochromes Format aufweisen (können aber zusätzlich ein Negativformat haben)

  Sättigung / Helligkeit / Kontrast

 

  Wiederherstellen der ursprünglichen Einstellungen
  

  Eine Farbe aus einem Bild entfernen

 1. Auf das Bild klicken.

Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Bildeigenschaften (Image properties) > Hintergrund löschen (Remove background) 
auf den kleinen Pfeil rechts neben dem Personen-Symbol klicken: 

 

 3. Auf Pipette (Color Picker) klicken.

Ihr Cursor verwandelt sich in eine Pipette

 4. Auf eine Stelle mit der betreffenden Farbe klicken.

 5. Unter Toleranz (Tolerance) ziehen Sie den Schieberegler nach links oder rechts, um den 
Schwellenwert anzupassen, ab dem die Farbe entfernt wird.

 6. Um den ursprünglichen Wert wiederherzustellen, auf

   klicken.                                 

Bild ändern

 1. Auf der Karte auf das Bild doppelklicken.

 2. Bilddatei auswählen.

▶  Wenn das Bild mit einer Spalte der Datentabelle verknüpft ist, wird das Bild in der Reihe, die 
der Karte entspricht, ebenfalls geändert

Bild fixieren

Texte, Bilder, mit Strichcodes verschlüsselte Daten und Allergeninformationen und Informationen über 
Allergene, die im Gegensatz zu „variabel“ als „fix“ (unveränderlich) bezeichnet werden, erscheinen auf 
sämtlichen Karten Ihres Dokuments und sind stets identisch.

 1. Mit der rechten Maustaste auf das  Element klicken und In variablen Text/ Bild / Barcode 
umwandeln auswählen.

▶  Es öffnet sich ein Fenster, in dem Sie die Umwandlung bestätigen können.

 2. Zur Bestätigung auf OK klicken.
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▶  Die verknüpfte Spalte wird aus der Datentabelle entfernt.

Die Daten in dieser Spalte können nicht mehr wiederhergestellt werden.

 

Logo hinzufügen/personalisieren.

  Hinzufügen eines Logos

Standardmäßig ist ein Logo ein „fixes“ Bild auf dem Hintergrund der Karte. Als „fix“ (unveränderlich) 
bezeichnete Elemente erscheinen auf sämtlichen Karten Ihres Dokuments und sind stets identisch.

 1. Auf das Symbol Logo hinzufügen (Add Logo) klicken.

▶  Ein neuer Bildbereich wird in der Mitte der Karte eingefügt und der Explorer öffnet sich.

 2. Das Bild auswählen, das als Logo verwendet werden soll.

 3. Auf Öffnen (Open) klicken, um das Logo dem Kartendesign hinzuzufügen.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.. 

Die Größe und Platzierung des Logos können geändert werden.

Ändern eines Logos

 1. Auf der Karte auf das Bild doppelklicken.

 2. Bilddatei auswählen.

▶  Wenn das Bild mit einer Spalte der Datentabelle verknüpft ist, wird das Bild in der Reihe, die 
der Karte entspricht, ebenfalls geändert

Die Quelle eines Logos bearbeiten

Es ist möglich, die Quelle eines Logos zu bearbeiten. Die Bildquelle kann sich auf der Festplatte (in 
einem auf dem Computer abgelegten Ordner oder auf einem Server) oder auch in der Webcam des 
Computers befinden.

 1. Im Design-Bereich auf das Logo klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Erweitert (Advanced) auf Bildquelle (Image source) klicken.

 3. In der Dropdown-Liste die gewünsche Quelle auswählen.

 4. Wenn Sie die Änderung vorgenommen haben, klicken Sie auf das Verzeichnissymbol.
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 l Wenn als Quelle „Bild von Datei“ ( From disk) ausgewählt wurde, öffnet sich der Explorer.
 l Wenn die ausgewählte Quelle Integrated Webcam ist, öffnet sich ein Fenster zur 

Bilderfassung.

 1. Für die Aufnahme auf das Webcam-Symbol klicken.

 2. Auf Aquire klicken, um das Foto in das Kartendesign einzufügen.

Barcode hinzufügen/personalisieren.

  Hinzufügen eines Barcodes

Hinzufügen eines völlig neuen 1D-Barcodes

Auf das Barcode- und dann auf das 1D-Barcode-Symbol klicken: 

  >  

Hinzufügen eines völlig neuen 2D-Barcodes

Auf das Barcode- und dann auf das 2D-Barcode-Symbol klicken: 

  >     

Hinzufügen eines 1D-Barcodes aus einer Spalte

Aus der Datentabelle den Spaltentitel auf die Karte ziehen und ablegen.

▶  Ein Barcode, der mit der entsprechenden Spalte in der Datentabelle verknüpft ist, wird auf der Karte 
angezeigt, sodass Sie ihn bearbeiten können.

Sie können den Barcode später noch fixieren.

Bearbeiten eines Barcodes

 1. Wenn er nicht bereits auf der Karte ausgewählt ist, klicken Sie auf den Strichcode.

 2. Die zu kodierenden Daten eingeben.

 3. Eingabetaste drücken.

▶  Wenn der Barcode mit einer Spalte der Datentabelle verknüpft ist, werden auch die Daten in 
der entsprechenden Reihe geändert

1D-Barcode formatieren

Drucken Sie nach der Formatierung eines 1D-Strichcodes eine Testkarte, um 
sicherzustellen, dass der Strichcode lesbar ist, bevor Sie eine größere Menge drucken.
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Auf den Barcode klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

  Kodierung  

    Barcode

  Kodierungsstandards   

     

  Optimierung der Lesbarkeit Erweitert (Advanced)>Barcode>Optimieren 
(Optimize)

  Zusätzliche Ziffer, die zur Überprüfung der 
restlichen gelesenen Daten verwendet wird

Erweitert (Advanced)>Barcode>Prüfziffer 
(CheckDigit)

     

  Abmessungen / Anordnung

  Breite der vertikalen Balken/Striche Erweitert (Advanced)>Barcode>Modulbreite 
(Module width)

  Verhältnis der vertikalen Balken Erweitert (Advanced)>Barcode>Wiedergabe 
(Rendering)

  Leerraum auf beiden Seiten der vertikalen Balken Erweitert (Advanced)>Barcode>Quiet Zone 
(Quiet Zone)

  Balken, die die vertikalen Striche einrahmen Erweitert 
(Advanced)>Barcode>Führungsbalken (Bearer 
bar)

  Breite der Balken, die die vertikalen Striche 
einrahmen

Erweitert (Advanced)>Barcode>Führungsbreite 
(Bearer width)

     

  ( Sichtbare Zeichen

  Anzeigen der kodierten Daten als sichtbare Zeichen 
auf der Karte

Barcode > Beschriftung (Human readable)

    Schriftart (Font)

  Schriftart

  Farbe der Zeichen
 

  Größe der Zeichen

  Gesamtbreite der Zeichen wird automatisch an die Erweitert (Advanced)>Barcode>Text dem 
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Breite der Balken/Striche angepasst Barcode anpassen (Fit Text to Barcode)

     

  Farbe

    Schriftart (Font)

  Farbe des Barcodes und der Zeichen
 

    Format

  Farbe des Hintergrunds
 

  Farbe des Rahmens
 

  2D-Barcode formatieren

Drucken Sie nach der Formatierung eines 2D-Strichcodes eine Testkarte, um 
sicherzustellen, dass der Strichcode lesbar ist, bevor Sie eine größere Menge drucken.

Auf den Barcode klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

  Kodierung

    Barcode

  Zeichensatz, der kodiert werden kann Erweitert (Advanced)>Barcode>Code-Seite 
(Code Page)

  Kodierungsformat für QRCode Erweitert (Advanced)>Barcode>QRCode Format

  Kodierungsformat für Datamatrix Erweitert (Advanced)>Barcode>Datamatrix 
Code

  Kodierungsformat für PDF417 Erweitert (Advanced)>Barcode>PDF417 
Kodierung (PDF417 Encoding)

  Kodierungsformat für Maxicode Erweitert (Advanced)>Barcode>Maxicode Mode

  Optionen zum Anhängen mehrerer Maxicode-
Barcodes

Erweitert (Advanced)>Barcode>Anhängen # 
(Append #)

  Kodierungsformat AZTEC Rune Erweitert (Advanced)>Barcode>AZTEC Mode

     

  Optimierung der Lesbarkeit Erweitert (Advanced)>Barcode>Optimieren 
(Optimize)

  Anpassen der Matrixanordnung Erweitert (Advanced)>Barcode>Maske (Mask)



Kartendesign Barcode hinzufügen/personalisieren.

26

  Redundanz zur Gewährleistung der Lesbarkeit, 
wenn ein Teil des Strichcodes verschmutzt oder 
beschädigt ist

Erweitert (Advanced)>Barcode>EC Level

     

  Abmessungen / Anordnung

  Anzahl der Quadrate, die die Matrix bilden Erweitert (Advanced) > Barcode > Größe (Size)  
> Größe/Version (Size/Version)

  Größe der Quadrate, die die Matrix bilden Erweitert (Advanced)>Barcode>Modulbreite 
(Module width)

  Höhe der Reihen in der Matrix Erweitert (Advanced) >Barcode >Zeilenhöhe 
(Row height)

  Breite der Spalten in der Matrix Erweitert (Advanced)>Barcode>Spaltenbreite 
(Column width)

  Datensegmente pro Reihe Erweitert (Advanced)>Barcode>Datensegmente 
(Data Segments)

  Verhältnis zwischen Reihen und Spalten) Erweitert (Advanced)>Barcode>R/C Verhältnis 
(R/C Ratio)

  Leerer Raum um die Matrix Erweitert (Advanced)>Barcode>Quiet Zone 
(Quiet Zone)

     

  Farbe

    Schriftart (Font)

  Farbe der Quadrate, die die Matrix bilden
 

    Format

  Farbe des Hintergrunds
 

  Farbe des Rahmens
 

  Barcode fixieren

Texte, Bilder, mit Strichcodes verschlüsselte Daten und Allergeninformationen und Informationen über 
Allergene, die im Gegensatz zu „variabel“ als „fix“ (unveränderlich) bezeichnet werden, erscheinen auf 
sämtlichen Karten Ihres Dokuments und sind stets identisch.

 1. Mit der rechten Maustaste auf das  Element klicken und In variablen Text/ Bild / Barcode 
umwandeln auswählen.

▶  Es öffnet sich ein Fenster, in dem Sie die Umwandlung bestätigen können.

 2. Zur Bestätigung auf OK klicken.
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▶  Die verknüpfte Spalte wird aus der Datentabelle entfernt.

Die Daten in dieser Spalte können nicht mehr wiederhergestellt werden.

 

 

Form hinzufügen/personalisieren

  Form hinzufügen

 1. Auf das Form-Symbol klicken:

 

 2. Dann auf eine Form im Menü:

 

▶  Die Form wird auf der Karte angezeigt und lässt sich formatieren, dimensionieren und 
positionieren:

Eine Form formatieren

Auf die Form klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

    Format

  Hintergrundfarbe
 

  Farbe des Rahmens
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Deckkraft (Opazität) Erweitert (Advanced)>Element (Item)>Deckkraft 
(Opacity)

Hinzufügen / Personalisieren einer vCard

Eine Vcard ermöglicht es, die auf einer Visitenkarte gedruckten Informationen in einen QR-Code zu 
kodieren. Durch Scannen dieses QR-Codes kann ein Benutzer einen neuen Kontakt in seinem Telefon 
anlegen, das Unternehmen mit einer GPS-Anwendung lokalisieren, die angegebene Telefonnummer 
anrufen, eine E-Mail an die E-Mail-Adresse senden, die Informationen kopieren oder weitergeben.

Je nach Marke des Smartphones, das zum Scannen der vCard verwendet wird, kann das 
Hinzufügen von Informationen zu einem neuen Kontakt die folgenden Wirkungen haben:

 l Die Felder, die mit der Adresse verknüpft sind (Felder 9 bis 13), können alle in 
einem einzigen Feld des Kontakts zusammengefasst werden.

 l Die Felder, die mit der Beschäftigung verknüpft sind (Felder 4 bis 6), können alle in 
einem einzigen Feld des Kontakts zusammengefasst werden.

Gute Lesbarkeit des Vcard-QR-Codes sicherstellen
 l Der Vordergrund (standardmäßig schwarz) muss eine dunklere Farbe aufweisen als der 

Hintergrund (standardmäßig weiß).
 l Die Kombination aus gelbem Vordergrund und weißem Hintergrund macht den QR-Code 

unlesbar.
 l Zwischen dem Vorder- und Hintergrund des QR-Codes muss ein ausreichender Kontrast 

bestehen.
 l Die Mindestgröße für gute Lesbarkeit ist 2x2 cm.
 l Einen Rahmen in der gleichen Farbe wie der Hintergrund des QR-Codes von mindestens 1/4 pt 

einfügen.

Vcard hinzufügen

Auf das Symbol vCard klicken.

▶  Auf der Karte erscheint ein QR-Code. Der vCard-QR-Code wird in allen Reihen der Datenbank 
angezeigt.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

Informationen speichern

Klassischer vCard-Modus

 1. Wenn er nicht bereits auf der Karte ausgewählt ist, auf den vCard-QR-Code klicken.
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▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Im Abschnitt vCard-Felder (vCard Fields): 
 l Jedes Feld kann mit einer Spalte in der bestehenden Datenbank verknüpft werden.

 a. Auf den Pfeil neben dem Feld Spalte auswählen… (Choose Column) klicken.

 b. Die Spalte in Ihrer Datentabelle wählen.
 l Sie können die Informationen manuell eintragen.

Manuell eingegebene Informationen werden allen Reihen der Datenbank 
zugewiesen.

 

▶  Die eingetragenen Informationen für die ausgewählte Zeile werden nachstehend 
angezeigt.

Das Kontaktfoto ist nur verfügbar, wenn der dynamische vCard-Modus 
aktiviert ist.

Dynamischer vCard-Modus

Beim klassischen vCard-Modus werden die Informationen im QR-Code selbst gespeichert. Je mehr 
vCard-Felder ausgefüllt werden, desto dichter ist der QR-Code, was ihn je nach Größe unleserlich 
machen kann.
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5 ausgefüllte vCard-Felder 15 ausgefüllte vCard-Felder

Beim dynamischen vCard-Modus speichert der QR-Code nur eine URL und ändert sich nicht, wenn 
neue Felder ausgefüllt werden. Alle Informationen werden auf einem öffentlichen Server gespeichert 
Badgy. Dadurch wird der QR-Code weniger dicht. Wenn der QR-Code gescannt wird, werden die 
Kontaktinformationen über die URL auf das Telefon heruntergeladen.

Der Computer muss mit dem Internet verbunden sein, um den dynamischen vCard-
Modus zu verwenden.

Zum Zeitpunkt des Scannens des vCard-QR-Codes muss das Telefon mit dem Internet 
verbunden sein (mobile Daten oder Wi-Fi).

Wenn der dynamische vCard-Modus aktiviert ist, müssen Sie das Dokument immer 
speichern, nachdem Sie Änderungen an einem vCard-QR-Code vorgenommen haben. Vor 
dem Speichern des Dokuments ist der QR-Code unlesbar und die Informationen werden 
nicht auf dem Server gespeichert/aktualisiert.

So aktivieren Sie den dynamischen vCard-Modus :

Bei Verwendung des dynamischen vCard-Modus:
 l Nach dem Löschen einer Zeile aus der Datentabelle sind die mit dieser Zeile 

verbundenen Informationen nicht mehr verfügbar. Das Scannen des QR-vCard-
Code auf einer zuvor gedruckten Karte ermöglicht keinen Zugriff mehr auf die 
Kontaktinformationen.

 l Das Entfernen des QR-vCard-Code aus einem Kartendesign führt dazu, dass die mit 
diesem QR-Code verbundenen Informationen nicht mehr verfügbar sind. Das 
Scannen von zuvor gedruckten Karten ermöglicht keinen Zugriff mehr auf die 
Kontaktinformationen.

 l Das Arbeiten mit 2 Kopien desselben Dokuments Badge Studio (kopiert aus dem 
Windows Explorer oder macOS Finder) führt zu Inkonsistenzen, wenn in einem 
Dokument Zeilen hinzugefügt, geändert oder gelöscht werden, nicht jedoch im 
andern.

 l Wenn ein Dokument mit „Speichern unter...“ gespeichert wird, haben die beiden 
Versionen des Dokuments unterschiedliche vCard-QR-Codes. In diesem Fall können 
beide Versionen des Dokuments ohne Inkonsistenzen verwendet werden.

 1. Wenn er nicht bereits auf der Karte ausgewählt ist, auf den vCard-QR-Code klicken.
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 2. Unter vCard-Felder (vCard Fields) aktivieren Sie das Kontrolllkästchen Dynamischen vCard-
Modus aktivieren (Activate dynamic vCard mode).

 3. Ein Pop-up-Fenster wird angezeigt, das Sie darüber informiert, dass für jede Zeile der 
Datentabelle neue vCard-QR-Codes erstellt werden und alle Karten neu gedruckt werden 
müssen.

 4. Klicken Sie auf Ja, um die Option zu aktivieren.

 5. Klicken Sie auf das Symbol Speichern (Save).

vCard-Informationen bearbeiten

 1. Wenn er nicht bereits auf der Karte ausgewählt ist, auf den vCard  QR-Code klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Klicken Sie auf Inhalt löschen (Delete content) um alle Felder zu leeren und neue 
Informationen einzugeben.

ODER

 3. Die Informationen direkt in der Datenbank ändern.

▶  Sie werden dann auf der Karte und in der Übersicht der vCard-Felder geändert.

 4. Klicken Sie auf das Symbol Speichern (Save).

vCard-QR-Code formatieren

Wenn er nicht bereits auf der Karte ausgewählt ist, auf den Strichcode klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

    Format

  Farbe des QR-Codes

  Farbe des Hintergrunds

  Farbe des Rahmens

  Reproduzieren der Formatierung

    Format > Muster (Pattern)

  Die Form des Motivs des vCard QR-Codes ändern

    Format > Organisieren (Arrange)
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  Präzises Ausrichten des QR-Codes

  Präzises Drehen des QR-Codes

  QR-Code nach vorn/hinten bewegen

  Hinzufügen und Personalisieren eines Vcard-QR-Codes

VCard QR-Codes können personalisiert werden, indem man dem QR-Code ein Bild hinzufügt (z. B. das 
Logo Ihres Unternehmens).

Bild in die Mitte des vCard-QR-Codes einfügen

Ein Logo in der Mitte eines vCard QR-Codes hinzufügen

 1. Wenn er nicht bereits auf der Karte ausgewählt ist, auf den vCard  QR-Balkencode klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Logo, auf das Verzeichnissymbol klicken und das gewünschte Bild auswählen.

 3. Das Logo wird in der Mitte des vCard-QR-Codes hinzugefügt, ggf. mit einem weißen 
Hintergrund.
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Die Größe eines Logos in einem vCard QR-Code ändern

 1. Wenn er nicht bereits auf der Karte ausgewählt ist, auf den vCard QR-Code klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Die Messskala verwenden, um die Größe des Logos anzupassen.

Klein: Das Logo nimmt 5 % des QR-Codes ein.

Mittel: Das Logo nimmt 8 % des QR-Codes ein (Standardeinstellung).

Groß: Das Logo nimmt 11 % des QR-Codes ein.

Logo von einem vCard QR-Code entfernen

 1. Wenn er nicht bereits auf der Karte ausgewählt ist, auf den vCard-QR-Code klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Logo klicken Sie auf das Wiederherstellungssymbol neben Datei durchsuchen (Browse 
file):

▶  Das Logo wird aus dem vCard-QR-Code und der ausgewählten Logo-Übersicht entfernt.

Elemente dimensionieren / positionieren

Bild beschneiden

  Auf das Bild klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

Vollständiges Ausfüllen des vorhandenen Rahmens

Unter Erweitert (Advanced) >  Anpassen (Fit)auf Dem Feld entsprechend zuschneiden (Crop to 
Fit) klicken.

Anzeigen des gesamten Bilds in seinem vorhandenen Rahmen

Unter Erweitert (Advanced)> Anpassen (Fit)auf Feld reduzieren (Shrink to fit) klicken.

Beschneiden eines bestimmten Bildbereichs

 1. UnterFormat auf das Zuschneiden-Symbol klicken.
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 2. Die roten Quadrate verschieben, um den gewünschten Bereich des Bildes einzuschließen:

 

 3. Auf Zuschneiden (Crop) klicken.

Beschneiden eines Bilds gemäß einer Form

 1. Unter Format auf den kleinen Pfeil rechts neben dem Symbol mit zwei sich überschneidenden 
Formen (Quadrat und Kreis) klicken:

 

 2. Dann eine der aufgelisteten Formen auswählen:

 

▶  Teile des Bildes werden ausgeblendet, um das Bild an die ausgewählte Form anzupassen:

Verschieben eines Elements auf die andere Seite der Karte

 1. Wenn die Rückseite der Karte nicht angezeigt ist, auf  

 klicken.                                 

 2. Auf das Element klicken und Cursor auf den Rahmen setzen, sodass der vierköpfige Pfeil 
erscheint.
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 3. Auf das Element klicken und es auf die andere Kartenseite ziehen.

Ein Element vor-/zurückbewegen

  Elemente auf einer vorderen Ebene überlagern (verdecken) die Elemente im selben Bereich, die auf 
einer hinteren Ebene angeordnet sind. Jedes Element der Karte ist einer bestimmten Ebene zugeordnet, 
die ihre Sichtbarkeit im Verhältnis zu den anderen bestimmt.

Für eine Ebene nach vorn

Mit der rechten Maustaste auf ein Element klicken, dann auf Ebene nach vorne (Bring forward) oder 
In den Vordergrund (Bring to front) klicken.

Für eine Ebene nach hinten

Mit der rechten Maustaste auf ein Element klicken, dann auf Ebene nach hinten (Send backward) 
oder In den Hintergrund (Send to back) klicken.

Ein Element neu dimensionieren, um die Karte proportional zu füllen

  Mit der rechten Maustaste auf ein Element und dann auf An Karte anpassen (Fit to Card) klicken.

Ausrichten / Verteilen der Elemente

   1. Strg (Windows) / cmd (MacOS) gedrückt halten und auf die gewünschten Elemente klicken, die 
ausgerichtet/verteilt werden sollen.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. UnterFormat > Organisieren (Arrange)auf das Ausrichtungs-Symbol klicken und eine Option 
auswählen:

  

  

Präzises Drehen eines Elements

   1. Auf das gewünschte Element klicken.
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▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Format > Organisieren (Arrange) auf den kleinen Pfeil rechts neben dem 
Drehungssymbol klicken und eine der vordefinierten Optionen auswählen oder den 
Drehungswinkel in das Feld eingeben:

 

 

Ein Element genau dimensionieren/positionieren

   1. Auf das Element klicken, das Sie dimensionieren/positionieren möchten.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Erweitert (Advanced) auf Größe (Size) > Position klicken.

 3. Breite/Höhe/Position in das Feld eingeben:  

 

Elemente sperren/ausblenden

Ein Element auf der Karte sperren / entsperren

   1. Auf das Element klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Erweitert (Advanced) > Element (Item) ankreuzen oder deaktivieren Element schützen 
(Lock item).

Alle Elemente ohne Passwort sperren

  Im Kartendesign-Bereich der Karten auf das Vorhängeschloss klicken (nicht auf den kleinen Pfeil rechts): 

▶  Die Daten in der Datentabelle, die mit den Elementen auf der Karte verknüpft sind, werden nicht 
gesperrt

Ein Drucken von Karten ist immer möglich.
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Sperren von Kartenelementen mit Kennwort

 1. Auf den kleinen Pfeil rechts neben dem Vorhängeschloss klicken.

 

Dann auf Vorlage mit Kennwort sperren (Lock design with password) >  klicken.

 2. Beliebiges Kennwort eingeben und bestätigen:

  

Wenn Sie Ihr Kennwort vergessen, können Sie es nicht selbst zurücksetzen

 

 3. Auf OK klicken.

Die Daten in der Datentabelle, die mit den Elementen auf der Karte verknüpft sind, 
werden nicht gesperrt

Ein Drucken von Karten ist immer möglich.

Entsperren von Elementen auf der Karte

   1. Im Design-Bereich der Karten auf das Vorhängeschloss klicken (nicht auf den kleinen Pfeil rechts): 

 

 2. Das vorher festgelegte Kennwort eingeben.

 3. Auf OK klicken.

 
Diese Aktion bewirkt kein Entsperren von gesperrten Spalten, die mit Elementen auf der 
Karte verknüpft sind.

Kennwort-Sperre deaktivieren

 1. Im Kartendesign-Bereich auf den kleinen Pfeil rechts neben dem Vorhängeschloss klicken.
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Dann auf Kennwort-Sperre deaktivieren (Disable password protection) klicken.

 2. Das vorher festgelegte Kennwort eingeben.

 3. Auf OK klicken.

Elemente auf der Karte ausblenden / einblenden

  In der Spaltenüberschrift, die mit dem Element verknüpft ist, auf das Augen-Symbol klicken.

 / .

Ein ausgeblendetes Element wird nicht gedruckt.

Elemente kopieren/löschen

Kopieren/Einfügen eines Elements

   1. Mit der rechten Maustaste auf ein Element und dann auf Kopieren (Copy)  klicken.

 2. Auf der Seite und im Bereich, wo die Kopie eingefügt werden soll, mit der rechten Maustaste 
klicken, dann auf Einfügen (Paste) klicken.

▶  Wenn variabel, wird das duplizierte Element mit einer neuen Spalte in der Datentabelle 
verknüpft.

Element duplizieren

  Mit der rechten Maustaste auf ein Element und dann auf Dubletten (Duplicate) klicken.

Wenn variabel, werden das ursprüngliche Element und die duplizierten Elemente mit 
derselben Spalte in der Datentabelle verknüpft und gemeinsam aktualisiert, wenn eines 
von ihnen geändert wird.

Element löschen

  Mit der rechten Maustaste auf ein Element und dann auf Löschen (Delete)  klicken.

Verknüpfte Spalten werden nicht aus der Datentabelle entfernt.
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Verwaltung von Daten
Datentabelle

 Die Datentabelle unterhalb des Kartendesign-Bereichs enthält die Daten, die Sie auf Ihre Karten drucken 
können. Sie ist in Spalten* (die jeweils Daten eines bestimmten Typs enthalten) und Reihen* (die jeweils 
einer Karte entsprechen) gegliedert.

 

 Hinzufügen einer Reihe
  

 Zwischen den Reihen navigieren (und die 
entsprechenden Karten anzeigen)   

 Daten suchen  

 Auswahl einer, mehrerer oder alles Reihen

 

 Löschen der ausgewählten Reihe(n)
  

Hinzufügen einer Reihe

  Am Fuß der Datentabelle auf das Plus-Symbol klicken:

  

▶  Eine Reihe, die auf der gleichen Kartenvorlage basiert und dieselben Elemente wie die anderen 
Karten enthält, wird dem Dokument hinzugefügt.

Sie können die Daten direkt in den Zellen dieser Reihe ändern.

Spalte hinzufügen

   1. Mit der rechten Maustaste auf einen beliebigen Spaltentitel klicken.

 2. Auf Spalte hinzufügen (Add column) klicken und den Typ der Spalte, die Sie hinzufügen 
möchten, auswählen (Barcode-Spalte hinzufügen (Add barcode column) /Bildspalte 
hinzufügen (Add image column) / Textspalte hinzufügen (Add text column)).

Sie können später kartenbezogene Elemente hinzufügen ( (Text, Bild, Strichcode).
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Daten hinzufügen/importieren

Vorbereiten einer externen Datenbank

  Eine Datenbank im Format einer Tabellenkalkulation vorbereiten

Die folgenden Regeln müssen beachtet werden:
 l Die Daten, die importiert werden können, sind in der Software verfügbare Objekte (Textfeld, 

Bilder, Barcode-Informationen, Logo usw.).
 l Die Tabelle wie folgt ausfüllen: Spaltennamen in der ersten Reihe der Tabellenkalkulation, Werte 

in den nachfolgenden Reihen.
 l Keine zusammengeführten Zellen einschließen. Sie können nicht in die Software importiert 

werden.
 l Um Bilder in eine Datenbank vom Typ Tabellenkalkulation aufzunehmen, ist die Link-Funktion zu 

verwenden.

Vorbereiten einer .txt-Datenbank

Die folgenden Regeln müssen beachtet werden:
 l Die erste Zeile dient als Beispiel für die gesamte .txt-Datei. Sie entspricht den Spaltentiteln der 

Datenbank. (1)
 l Beim Ausfüllen der .txt-Datei ist stets dem Beispiel der ersten Zeile zu folgen.
 l Zum Einfügen von Bildern den vollständigen Pfad und den Namen des Bildes (mit der 

Dateierweiterung) verwenden.
 l Wenn die Zeilen in einer bestimmten Reihenfolge importiert werden sollen, fügen Sie als ersten 

Eintrag eine Ziffer hinzu. Den Zeilennummern einen Spaltennamen hinzufügen, damit sie nicht 
als Einträge importiert werden. (2)

 l Die einzelnen Elemente durch ein Trennzeichen voneinander abgrenzen: Komma (,) oder 
Semikolon (;). (3)

Wenn kein Trennzeichen erkannt wird, läuft der Import nicht ordnungsgemäß.
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Importieren von Daten

Daten aus einem Excel- / CSV / .txt-Dokument exportieren

Die zu importierende Datei wählen

 1. Das Badge Studio-Dokument öffnen, in das die Daten importiert werden sollen.

 2. Auf Datei (File) > Daten importieren (Import data) klicken.

▶  Das Importfenster wird angezeigt.

 3. Auf die Registerkarte >  klicken.

 4. Auf Datei durchsuchen (Browse file) klicken, dann das Dokument mit den zu importierenden 
Daten auswählen.

Um die Daten in einem zu importierenden Excel-Dokument genau zu bestimmen:

 1. Die Option Erweiterte Optionen (Advanced options)  ankreuzen.

 2. Das Blatt aus der Dropdown-Liste auswählen und / oder den Zellbereich angeben, 
der die Daten enthält:

Für die Synchronisation der Daten mit einem Excel-Dokument:

 1. Die Option Erweiterte Optionen (Advanced options)  ankreuzen.

 2. Die Option Automatische Aktualisierung der Daten (Auto Import Data)  
ankreuzen.

 3. Eine der beschriebenen Optionen auswählen.

 5. Auf Weiter > (Next >) klicken.

  Elemente auf der Karte mit Spalten in der Datei verknüpfen.

▶  Das Dialogfeld zeigt die Elemente auf Ihrer Kartenvorlage auf der linken Seite und die Spalten des 
importierten Dokuments auf der rechten Seite an:
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 1. Weitere Spalten in meiner Tabelle anzeigen (Show more columns from my table)Anzeigen 
der Spalten in Ihrer Datentabelle, die nicht mit Elementen auf der Karte verknüpft sind

▶  Die Spalten werden unterhalb der Karte angezeigt:

 2. Für jedes Element (oder jede nicht verknüpfte Spalte), das mit einer Spalte des importierten 
Dokuments verknüpft werden soll, auf das Element (oder die Spalte) auf der linken Seite und 
dann auf die entsprechende Spalte auf der rechten Seite klicken.

▶  Verknüpfte Elemente und Spalten zeigen einen Punkt an, dessen Nummer und Farbe 
identisch sind:

(Optional) Um eine oder mehrere Referenzspalten genau zu bestimmen:

 1. Auf Erweitert (Advanced) klicken.

 2. Wenn es nicht bereits angekreuzt ist, das Kästchen neben der Spalte des 
importierten Dokuments aktivieren. 

 3. Auf das Schlüsselsymbol neben der Spalte des importierten Dokuments klicken:  

▶  Referenzspalten werden durch ein blaues Schlüsselsymbol gekennzeichnet 

 4. Auf OK klicken.

 3. Wenn Sie mit dem Verknüpfen von Elementen und Spalten fertig sind, klicken Sie auf Weiter > 
(Next >) und dann auf Fertigstellen (Finish).
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Daten bearbeiten

Bearbeiten von Daten des Typs Text in der Datentabelle

   1. In die Zelle der Datentabelle (Reihe, die der Karte entspricht) doppelklicken, die den zu 
bearbeitenden Wert enthält

 2. Den gewünschten Wert in die Zelle der Datentabelle eingeben.

 3. Eingabetaste drücken.

▶  Der Wert auf der Karte, der der Reihe entspricht, wird ebenfalls geändert.

Ein Bild in der Datentabelle ändern

   1. In die Zelle der Datentabelle doppelklicken (Reihe, die der Karte entspricht), die das zu 
bearbeitende Bild enthält.

▶  Der Explorer des Computers wird geöffnet.

 2. Bilddatei auswählen.

▶  Das Bild auf der Karte, das der Reihe entspricht, wird ebenfalls geändert

 

Ein Element mit einer anderen Spalte verknüpfen

  Beim Hinzufügen eines neuen Elements zur Karte wird automatisch eine entsprechende Spalte in der 
Datentabelle erstellt. Das Element kann mit einer anderen Spalte in der Datentabelle verknüpft werden 
(wenn Sie bereits eine Datenbank importiert haben, die Informationen für das Element enthält).

 1. Auf ein Element der Karte klicken

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Erweitert (Advanced)  > Datenbank (Database) in der Dropdown-Liste die zu 
verknüpfende Spalte auswählen. 

▶  Das Element ist nun mit einer neuen Spalte verknüpft und die auf der Karte angezeigten 
Daten werden aktualisiert.

Element fixieren

  Texte, Bilder, mit Strichcodes verschlüsselte Daten und Allergeninformationen und Informationen über 
Allergene, die im Gegensatz zu „variabel“ als „fix“ (unveränderlich) bezeichnet werden, erscheinen auf 
sämtlichen Karten Ihres Dokuments und sind stets identisch.

 1. Mit der rechten Maustaste auf das  Element klicken und In variablen Text/ Bild / Barcode 
umwandeln auswählen.

▶  Es öffnet sich ein Fenster, in dem Sie die Umwandlung bestätigen können.

 2. Zur Bestätigung auf OK klicken.

▶  Die verknüpfte Spalte wird aus der Datentabelle entfernt.
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Die Daten in dieser Spalte können nicht mehr wiederhergestellt werden.

Spalte umbenennen

   1. Mit der rechten Maustaste auf den Spaltentitel und dann auf Spalte umbenennen (Rename 
column)  klicken.

 2. Den neuen Namen der Spalte in das Feld mit dem Spaltentitel eingeben

 3. Eingabetaste drücken.

Daten suchen/sortieren

Daten suchen

   1. Die gesuchten Informationen in die Suchleiste eingeben (Text / Barcodedaten):

 2. Eine Spalte aus der Dropdown-Liste rechts neben der Suchleiste auswählen, um die Suche zu 
verfeinern:

  

▶  Es werden nur die Zeilen angezeigt, die den Suchkriterien exakt entsprechen

 3. Alle Zeichen im Suchfeld löschen, um alle Zeilen erneut anzuzeigen.

Spalten neu anordnen

  Mit der rechten Maustaste auf einen Spaltentitel und dann auf Nach links verschieben (Move left) 
oder Nach rechts verschieben (Move right)  klicken

Daten sperren/ausblenden

Eine Spalte sperren / Entsperren

 1. Mit der rechten Maustaste auf den Spaltentitel und dann auf Erweiterte Optionen (Advanced 
options)  klicken.

 2. Ankreuzen / Deaktivieren Spalte schützen (Protect column).

▶  Daten in einer gesperrten Spalte können nicht bearbeitet, kopiert oder gelöscht werden.
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Jedes Element, das mit einer gesperrten Spalte verknüpft ist, kann angepasst, 
dimensioniert und positioniert werden

Spalte ausblenden

  Mit der rechten Maustaste auf den Spaltentitel und dann auf Ausblenden (Hide) klicken.

▶  Die entsprechenden Elemente auf der Karte werden ebenfalls ausgeblendet.

Spalte anzeigen

   1. Mit der rechten Maustaste auf einen beliebigen Spaltentitel und dann auf Anzeigen (Unhide)  
klicken

 2. Kästchen der Spalte, die angezeigt werden soll, ankreuzen-

▶  Das entsprechende Element auf den Karten wird ebenfalls angezeigt.

Daten kopieren/exportieren

Kopieren und Einfügen einer Reihe 

   1. Mit der rechten Maustaste auf eine beliebige Zelle der Reihe mit den zu kopierenden Daten und 
dann auf  Linie kopieren (Copy line) klicken.

 2. Mit der rechten Maustaste auf eine beliebige Zelle in der Reihe mit den zu ersetzenden Daten 
und dann auf Linie einfügen (Paste line) klicken.

▶  Die bisherigen Daten in der Reihe werden ersetzt.

Reihe duplizieren

  Mit der rechten Maustaste auf eine beliebige Zelle der Reihe mit den zu duplizierenden Daten und dann 
auf  Linie duplizieren (Duplicate row) klicken.

▶  Der Datentabelle wird eine Reihe mit denselben Daten hinzugefügt.

Sie können diese Reihe später ändern, ohne dass eine Aktualisierung der anderen Reihe erfolgt

Einen Wert / ein Bild auf die gesamte Spalte propagieren

   1. Mit der rechten Maustaste auf die Zelle in der Datentabelle klicken, die den/das zu 
propagierende(n) Wert/das Bild enthält.

 2. Dieses Bild auf alle Zeilen anwenden (Apply image to all rows) / Diesen Wert auf alle 
Zeilen anwenden (Apply value to all rows) auswählen.

▶  Der Wert/das Bild wird in alle Zellen in derselben Spalte übernommen
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Sie können jede Zelle dieser Spalte nachträglich ändern, ohne dass die anderen Zellen 
aktualisiert werden

Exportieren von Daten

 1. Das Dokument mit den Daten, die exportiert werden sollen, öffnen.

 2. Auf Datei (File) > Daten exportieren (Export data) klicken.

 3. Auf das Verzeichnis-Symbol klicken:

 4. Den gewünschten Speicherort für die Daten wählen.

 5. Die Kästchen der Spalten deaktivieren, die vom Export ausgeschlossen werden sollen.

 6. Auf Exportieren (Export) klicken.

▶  Am ausgewählten Speicherort wird ein komprimierter Ordner mit einer Excel-Datei der 
exportierten Daten gespeichert.

Löschen von Daten

Reihen löschen

   1. Die Zeilen, die Sie löschen möchten, 
markieren.

 

   l Um eine oder mehrere Reihen zum Löschen 
auszuwählen, das oder die entsprechenden 
Kästchen ankreuzen.

 

   l Um einen ganzen Block von Reihen zum 
Löschen auszuwählen, das Kästchen am 
Anfang des Blocks ankreuzen, die 
Umschalttaste gedrückt halten und dabei 
das Kästchen am Ende des Blocks ankreuzen.

 

   l Um alle Reihen zum Löschen auszuwählen, 
das Kästchen über dem Kästchen der ersten 
Reihe ankreuzen.

 

   2. Auf das Papierkorb-Symbol klicken.  
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Gelöschte Daten können nicht 
wiederhergestellt werden.

Spalte löschen

  Mit der rechten Maustaste auf den Spaltentitel und dann auf Spalte löschen (Delete column)  klicken.

Gelöschte Daten können nicht wiederhergestellt werden.

Alle verlinkten Elemente auf der Karte werden ebenfalls gelöscht.
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Druck
Druckeinstellungen

  Die Seite mit den Druckeinstellungen wird angezeigt, nachdem Sie die zu druckenden Karten 
ausgewählt und im Karten-Design-Bereich auf das Druckersymbol geklickt haben. Hier können die 
Druckeinstellungen vor dem Starten des Druckvorgangs konfiguriert werden.

  

  Aktualisieren der Liste der verfügbaren Drucker
  

  Kartenformat Größe der Karte (Card size):

Lange Karte 120 x 50 mm (Long card 120 x 50 mm)

Lange Karte 150 x 50 mm (Long card 150 x 50 mm)

  Karten im üblichen Kreditkartenformat. CR80

  Einhaltung der ISO-Norm, die die physischen 
Eigenschaften von Karten festlegt

CR80 (ISO7810)

  Bedrucken der Vorderseite
  

Bedrucken der Rückseite

  

  Bedrucken von Vorder- und Rückseite

  

  Glättung (Anti-aliasing) Erweitert (Advanced)>Wiedergabe 
(Rendering)> Glätten (Anti-aliasing)

  Druckauflösung Erweitert (Advanced)>Druckereinstellungen 
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(Printer settings)>Auflösung (Resolution (DPI))

  Ausrichtung des Inhalts der Rück- im Verhältnis zur 
Vorderseite

Erweitert (Advanced)>Druckereinstellungen 
(Printer settings)>Rückseite um 180° drehen 
(Rotate Back 180 degrees)

  Starten des Drucks

  

Karten drucken

Prüfen des Druckers (Windows)

  Badgy Print Center öffnen (z. B. über das Startmenü von Windows oder ein Symbol auf dem Desktop)

Der Druckerstatus sollte Bereit (Ready)  anzeigen:

 

Wenn der Druckerstatus nicht „Bereit (Ready)“ lautet, konsultieren Sie die Support-Ressourcen 
(einschließlich des Benutzerhandbuchs) für Badgy-Drucker.

Karten zum Druck auswählen

  Um eine oder mehrere Zeilen zum Drucken 
auszuwählen, das oder die entsprechende(n) 
Kästchen ankreuzen.

 

  Um einen ganzen Block von Zeilen zum Drucken 
auszuwählen, das Kästchen am Anfang des Blocks 
ankreuzen, die Umschalttaste gedrückt halten und 
dabei das Kästchen am Ende des Blocks ankreuzen.

  

  Um alle Reihen zum Drucken auszuwählen, das 
Kästchen über dem Kästchen der ersten Zeile 
ankreuzen.

 

  

https://myplace.evolis.com/s/product/badgy-200/01t5p00000CXScjAAH?language=de&tabset-4085f=1
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Ein Element vom Drucken ausschließen

   1. Auf ein Element der Karte klicken

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Erweitert (Advanced)  > Element (Item)die Option Drucken (Print) deaktivieren.

Konfiguration ohne Drucken des Hintergrunds

   1. Auf Bearbeiten (Edit) > Hintergrund ändern (Edit card background) klicken.

▶  Das Eigenschaftenfeld wird rechts neben dem Kartendesign-Bereich angezeigt.

 2. Unter Erweitert (Advanced)  >  Hintergrund (Background)die Option Hintergrund nicht 
drucken (Don't Print Background) ankreuzen

Konfigurieren / Drucken starten

   1. Im Design-Bereich auf das Druckersymbol klicken:

 

▶  Das Bedienfeld für den Druck wird angezeigt:

 

 2. Konfigurieren der verfügbaren Druckeinstellungen

 3. Nach dem Konfigurieren der Druckeinstellungen auf das Symbol Drucken (Print) klicken.

Das Kästchen Druck der Rückseite anhand des doppelseitigen Druckassistenten (Print the back 
side using the duplex printing wizard) ankreuzen.
▶  Ein Assistent wird geöffnet: 
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Anweisungen auf dem Bildschirm befolgen.
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GRUNDLAGEN UND HILFE
  Fachbegriffe
  Glätten

Eine Technik, die auf eine glattere Darstellung der Pixel abzielt und das 
„zackige“ oder „ausgefranste“ Aussehen von Kanten abschwächt. In 
den Druckeinstellungen können Sie festlegen, ob die Glättung auf Text, 
Bilder oder beides angewendet werden soll.

   

  Helligkeit

Das Ausmaß, in dem ein Bild Licht auszustrahlen scheint. Eine höhere 
Helligkeit verschiebt den Tonwertumfang in Richtung Weiß.

gering hoch

  Kontrast

Unterschied zwischen hellen und dunklen Teilen eines Bilds. Ein hoher 
Kontrast vergrößert den Tonwertumfang und betont die Unterschiede 
zwischen den dunklen und hellen Teilen eines Bildes. Beim Drucken 
wird für einen höheren Kontrast der Druckkopf auf eine höhere 
Temperatur aufgeheizt und mehr Farbstoff auf die Karte aufgebracht.

gering hoch

  Graustufen

Abstufungen von absolutem Schwarz bis zu absolutem Weiß. Bei 
einem monochromen Schwarzweißbild fehlen solche Abstufungen 
zwischen absoluten Schwarz und absolutem Weiß.

 

  Monochrom

„Monochrom“ bedeutet „einfarbig“. Je nach Anwendungsbereich ist 
die genaue Bedeutung jedoch etwas unterschiedlich. 

In der Fotografie und im grafischen Bereich besteht ein monochromes 
Bild strikt aus absolutem Schwarz und absolutem Weiß, ohne 
Grauschattierungen oder andere Farben zwischen diesen beiden 
Extremen.

Im Druckgewerbe hat ein monochromes Farbband nur eine Farbe 
(meist schwarz oder weiß) und trägt daher entweder die Farbe seines 
Farbstoffs oder gar keinen Farbstoff auf.

Wenn Sie ein Bild mit einem monochromen Farbband drucken, müssen 
Sie:

 l Ein Bild mit nur hellen und dunklen Bereichen auswählen. Es 
darf keine Grauschattierungen oder andere Farben enthalten.

 l Umwandeln von Bildern in Monochrom-Format. Badge Studio 
bietet diese Formatierungsoption für ein Bild, das der Karte 
hinzugefügt wurde, oder für den Hintergrund der Karte.
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  Negativ

Ein Bild, bei dem die dunklen und hellen Farben vertauscht wurden. 
Bei einem monochromen Schwarzweißbild sind das absolute Schwarz 
und das absolute Weiß umgekehrt. Dies eignet sich besonders für das 
Drucken mit weißem Farbband auf schwarze Karten.

 

  Druckauflösung

Die Druckauflösung stellt die Dichte der Farbstoffpunkte dar, die der 
Druckkopf auf die Karte aufträgt. Sie wird in Dots per Inch (dpi) 
gemessen. Das Erhöhen der Druckauflösung kann die Qualität von 
Bildern mit feinen Details verbessern, verlangsamt jedoch die 
Druckgeschwindigkeit.

Die möglichen Druckauflösungen hängen vom Druckermodell und 
dem Farbbandtyp (Monochrom oder Farbe) ab:

Drucker Farbe / Monochrom Auflösung (dpi)

BADGY 100 Monochrom 300

BADGY 200 Monochrom 300

   

  Sättigung

Das Ausmaß, in dem ein Bild Licht auszustrahlen scheint.

gering hoch

  Barcode-Typen
  1D-Barcode

Klassischer Barcode, der Daten mithilfe von vertikalen Strichen kodiert.

 

  2D-Barcode

Barcode, der Daten in einer Matrix aus kleinen Quadraten kodiert.

2D-Strichcodes können mehr Daten kodieren als 1D-Strichcodes. Sie 
können daher für Webadressen oder detaillierte Chargeninformationen 
verwendet werden.

 

  QR-Code

Eingetragene Marke. Eine Kodierungsnorm für 2D-Barcodes.

   

  Kartenformate
  Kreditkarte

Karten in der Größe einer Kreditkarte (86 x 54 mm), die mit den 
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Lösungen geliefert werden.

  Hilfe

PDF herunterladen

Eine Version dieses Handbuchs können Sie im PDF-Format von hier herunterladen: www.evolis.com  > 
Support-Abschnitt > Produktseite.

Die PDF kann auch über die Schaltfläche Hilfe (Help) der Software aufgerufen werden.

Einführungsvideo starten

Das Einführungsvideo stellt die wichtigsten Funktionen von Badge Studio vor. Es startet bei der ersten 
Inbetriebnahme der Software.

Sie können das Video jederzeit von der Startseite aus starten: Klicken Sie einfach auf Hilfe (Help) > 
Einführungsvideo von Edikio starten (Launch guided tour video).

Tutorials

 Sehen Sie sich die Videotutorials auf dem YouTube-Kanal von Badgy an.

Wissensdatenbank

Nachschlagen in der  Online-Wissensdatenbank.

Technischer Support

 l Wenden Sie sich an die Support-Abteilung Ihres Händlers.
 l Füllen Sie dieses Formular online aus.

https://de.evolis.com/
https://www.youtube.com/@badgycardprinter/featured
https://myplace.evolis.com/s/topic/0TO5p000001UPchGAG/evolis-badge-studio?language=de
https://myplace.evolis.com/s/contactsupport?
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D

Daten
Text, Bilder, mit Strichcodes verschlüsselte Daten und Informationen über Allergene, die in der 
Datentabelle enthalten sind.

Datentabelle
Die Datentabelle enthält und verwaltet die Daten, die auf den Karten Ihres Dokuments 
dargestellt werden können.  Sie ist unterteilt in Spalten und Reihen.

Dokument
Eine Badge Studio-Datei (mit der Endung .bs), die eine Datentabelle und eine Kartenvorlage für 
eine Kartenserie enthält.

E

Element
Elemente, die der Kartenvorlage hinzugefügt und personalisiert / formatiert werden können. 
Ein variables Element ist mit einer Spalte in der Datentabelle verknüpft.

F

fix
Die fixen (im Gegensatz zu den variablen) Elemente der Kartenvorlage sind auf allen Karten 
Ihres Dokuments identisch, d. h. sie sind auf jeder Karte enthalten. Beispielsweise wollen Sie ein 
„fixes“ Bild Ihres Logos hinzufügen, das auf jeder Karte zu sehen sein wird.

R

Referenzspalte
Eine Spalte, die dazu dient, doppelte Reihen zu erkennen und zu verwalten. Die Referenzspalte 
kann automatisch von der Software festgelegt oder vom Benutzer definiert werden. Sie kann 
mit einem Element auf der Karte verbunden sein - oder auch nicht. Es ist möglich, mehr als eine 
Referenzspalte für dieselben Daten zu definieren, wenn eine einzige Referenzspalte nicht 
ausreicht, um die Reihen eindeutig zu identifizieren.

Reihe
Jede Reihe der Datentabelle enthält die Daten für eine einzelne Karte. Jede neue Reihe, die der 
Datentabelle hinzugefügt wird, fügt der Kartenserie eine entsprechende Karte hinzu.



Glossar

58

S

Spalte
Eine Spalte enthält Daten eines bestimmten Typs innerhalb einer Datentabelle, beispielsweise 
eine Spalte „Herkunft“ mit einem Ortsnamen für jede Reihe (die eine Karte verkörpert). Wenn 
eine Spalte mit einem variablen Element auf der Karte verknüpft ist, dient sie als Datenquelle.

V

Variable
Die variablen Elemente können (im Gegensatz zu den fixen) von Karte zu Karte individuell 
geändert oder auf Wunsch auch weggelassen werden. Ein variables Bild kann z. B. die 
möglichen Allergene zeigen, die ein Produkt enthält.

Vorlage
Die von Evolis gelieferten Schildervorlagen sind in der Kartothek verfügbar.  Sie sind bereits mit 
einem Hintergrund und mehreren Objekten versehen, die vom Benutzer bearbeitet und 
personalisiert werden können.

W

Wert
Ein Wert entspricht den spezifischen Daten, die für eine einzelne Zelle in der Datentabelle 
spezifisch sind.



Weitere Informationen erhalten Sie hier: www.badgy.com

Evolis

14 Avenue de la Fontaine - ZI Angers-Beaucouzé - 49070 Beaucouzé - France

T +33 (0) 241 367 606 - F +33 (0) 241 367 612

https://www.badgy.com/
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